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Understanding Proposal Development 
 

1.   The Proposal Development Module has been designed to allow department 
administrators and investigators to construct full proposals from the desktop. Coeus can be 
used to route ALL proposals, no matter the sponsor. 
 
The Aggregator is required to create a proposal shell, which includes the basic header 
information similar to what is found on the ORD Routing Form. Once the Proposal 
Details information is complete, work on the proposal can be distributed to other 
investigators and/or administrators, allowing collaborative efforts in completing the 
proposal for submission. If the proposal is to be submitted to the sponsor on paper (as 
opposed to submitting electronically) You can still create your proposal in Coeus and 
route it electronically through your department/school and to the ORD office for approval 
before printing and submitting to the sponsor. 

2.   The Proposal Budget section allows you create, modify and finalize Detailed as well as 
Modular Budgets. 
 
The Proposal Budget section stores all Employee Benefit, Inflation and F&A rates and 
applies these rates to budget line items. This allows Coeus to automatically calculate the 
total budget, applying cost elements and their applied rates over multiple periods within 
any given budget(s). 

3.   The Proposal Narrative section allows you to upload documents such as Science 
Narratives, Bibliographies, Equipment details etc. 

4.   The Approval section allows you to finalize your proposal. These tasks include answering 
Yes/No Questions, certifying investigators, validating and ultimately submitting your 
proposal for approval routing. 

5.   You have successfully learned the four separate components within the Proposal 
Development Module in Coeus. 
End of Procedure. 

6.   The Proposal Development Module has been designed to allow department 
administrators and investigators to construct full proposals from the desktop. Coeus can be 
used to route ALL proposals, no matter the sponsor. 
 
The Aggregator is required to create a proposal shell, which includes the basic header 
information similar to what is found on the ORD Routing Form. Once the Proposal 
Details information is complete, work on the proposal can be distributed to other 
investigators and/or administrators, allowing collaborative efforts in completing the 
proposal for submission. If the proposal is to be submitted to the sponsor on paper (as 
opposed to submitting electronically) You can still create your proposal in Coeus and 
route it electronically through your department/school and to the ORD office for approval 
before printing and submitting to the sponsor. 
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7.   The Proposal Budget section allows you create, modify and finalize Detailed as well as 
Modular Budgets. 
 
The Proposal Budget section stores all Employee Benefit, Inflation and F&A rates and 
applies these rates to budget line items. This allows Coeus to automatically calculate the 
total budget, applying cost elements and their applied rates over multiple periods within 
any given budget(s). 

8.   The Proposal Narrative section allows you to upload documents such as Science 
Narratives, Bibliographies, Equipment details etc. 

9.   The Approval section allows you to finalize your proposal. These tasks include answering 
Yes/No Questions, certifying investigators, validating and ultimately submitting your 
proposal for approval routing. 

10.   You have successfully learned the four separate components within the Proposal 
Development Module in Coeus. 
End of Procedure. 

11.   The Proposal Development Module has been designed to allow department 
administrators and investigators to construct full proposals from the desktop. Coeus can be 
used to route ALL proposals, no matter the sponsor. 
 
The Aggregator is required to create a proposal shell, which includes the basic header 
information similar to what is found on the ORD Routing Form. Once the Proposal 
Details information is complete, work on the proposal can be distributed to other 
investigators and/or administrators, allowing collaborative efforts in completing the 
proposal for submission. If the proposal is to be submitted to the sponsor on paper (as 
opposed to submitting electronically) You can still create your proposal in Coeus and 
route it electronically through your department/school and to the ORD office for approval 
before printing and submitting to the sponsor. 

12.   The Proposal Budget section allows you create, modify and finalize Detailed as well as 
Modular Budgets. 
 
The Proposal Budget section stores all Employee Benefit, Inflation and F&A rates and 
applies these rates to budget line items. This allows Coeus to automatically calculate the 
total budget, applying cost elements and their applied rates over multiple periods within 
any given budget(s). 

13.   The Proposal Narrative section allows you to upload documents such as Science 
Narratives, Bibliographies, Equipment details etc. 

14.   The Approval section allows you to finalize your proposal. These tasks include answering 
Yes/No Questions, certifying investigators, validating and ultimately submitting your 
proposal for approval routing. 

15.   You have successfully learned the four separate components within the Proposal 
Development Module in Coeus. 
End of Procedure. 
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Maintaining the Inbox 
 

1.   Users of the Coeus systems will log into Coeus via the Campus (myUMB) Portal. 
2.   a valid value e.g. "008178". 
3.   Click in the Password: field. 

 
4.   For this exercise, enter a valid value e.g. "coeus" into the Password: field. 
5.   Click the Sign In button. 

 
6.   Once you log into the Campus Portal, you will notice the Enterprise Menu on he left 

listing applications available for your use. 
 
To launch the Coeus application, 
Click the Coeus link. 

 
7.   The first time you launch Coeus at your workstation, the server will install all of the 

necessary components to run the application. 
 
There are a few requirements that need to be met prior to running Coeus for the first time: 
 
* You will need Java Runtime installed on the workstation. 
* You will need Adobe Acrobat Creator (not the free Reader) installed for Coeus to 
populate the forms to submit to Grants.gov. 

8.   Coeus Requires its own login combination and a login box appears. Again, you will use 
your myUMB ID and password combination. 
 
Enter a valid value e.g. "008178" into the User Name : field.  

9.   Click in the Password : field. 
 

10.   Enter a valid value e.g. "coeus" into the Password : field.  
11.   Click the OK button. 

 
12.   The first time you log in to Coeus to work with your inbox, you may wish to view the e-

mail notification settings. These settings allow you to choose whether or not you would 
like any workflow notifications to be sent to your e-mail. 
 
All workflow notification are delivered to your Coeus Inbox, regardless of whether you 
elect to have these notifications delivered to your e-mail as well. 

13.   To view these settings 
Click the File menu. 
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14.   Click the Preferences menu. 
 

15.   There is one setting for which you can change. 
Click the Email Notifications list. 

 
16.   It is your choice. You can choose to receives theise notifications via e-mail or not. 

 
However, if you choose to turn Email Notifications off, you will need to be diligent about 
visiting your Coeus Inbox regularly to view any item needing your attention, such as 
approving a proposal. 
Click the OK button. 

 
17.   Next, begin by navigating to your Coeus Inbox. 

Click the File menu. 
 

18.   Click the Inbox menu. 
 

19.   Your Coeus Inbox will display all items needing your attention.  
 
The Coeus Inbox has two tabbed panels: 
   • Unresolved 
   • Resolved 
 
The Unresolved tab displays the items needing action, such as Proposals awaiting your 
approval. 
The Resolved tab displays those items on which you have already taken action. 
 
If you are an Approver, your Inbox will have proposals waiting for your approval. 
If you are also a Proposal Aggregator, you will see any proposals you have submitted 
that have been denied. 

20.   You can sort the items in your Inbox, under either the Resolved or Unresolved tab, by 
clicking the column header above the column you wish to sort by. 
 
For this exercise, you will sort your Unresolved Items by Deadline. 
Click the Deadline column header. 

 
21.   The Inbox items are now sorted by Deadline Date. 

 
Notice the color coding for each item in your Inbox. 
 
   • RED items are due to the Sponsor in 3 days or less 
   • YELLOW items are due to the Sponsor in 4-5 days 
   • GREEN items are due to the Sponsor in 6-10 days 
   • NO COLOR items (white background) are due to the Sponsor in 10+ days 
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22.   You can select any item in your Inbox by clicking on it. 
 
When you select an item in your Inbox, you can view the workflow comments attached to 
the proposal in the Message box below. 

23.   Click the Resolved tab. 
 

24.   The Resolved Tab displays those items on which you have already taken action. 
 
Items move to the Resolved tab automatically once you have taken action on an item in 
your Unresolved list, such as approving or rejecting a proposal. 

25.   The list of items under your Resolved tab will continue to increase as you take action on 
items. You can remove items in your Resolved items by deleting them. 
 
Click the entry containing Proposal 00000285. 

26.   Click the Delete the selected message button. 

 
27.   Coeus will ask you to confirm that you would like to delete the selected message. 

Click the Yes button. 
 

28.   Proposal 0000061 has been removed from your Resolved Action Items. 
 
Note: Only items that have moved to your Resolved Action Items area can be deleted. 
Click the Unresolved tab. 

 
29.   If you receive new Action Items needing your attention while you are working with your 

Inbox, you will need to refresh your Inbox to view these newly delivered items. 
30.   Click the Refresh the view button. 

 
31.   Your newly delivered Items now appear in your Inbox Unresolved Items list. 
32.   In this topic you have learned to maintain your Inbox by managing Resolved and 

Unresolved action Items. 
End of Procedure. 

33.   Users of the Coeus systems will log into Coeus via the Campus (myUMB) Portal. 
34.   a valid value e.g. "008178". 
35.   Click in the Password: field. 

 
36.   For this exercise, enter a valid value e.g. "coeus" into the Password: field. 
37.   Click the Sign In button. 
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38.   Once you log into the Campus Portal, you will notice the Enterprise Menu on he left 
listing applications available for your use. 
 
To launch the Coeus application, 
Click the Coeus link. 

 
39.   The first time you launch Coeus at your workstation, the server will install all of the 

necessary components to run the application. 
 
There are a few requirements that need to be met prior to running Coeus for the first time: 
 
* You will need Java Runtime installed on the workstation. 
* You will need Adobe Acrobat Creator (not the free Reader) installed for Coeus to 
populate the forms to submit to Grants.gov. 

40.   Coeus Requires its own login combination and a login box appears. Again, you will use 
your myUMB ID and password combination. 
 
Enter a valid value e.g. "008178" into the User Name : field.  

41.   Click in the Password : field. 
 

42.   Enter a valid value e.g. "coeus" into the Password : field.  
43.   Click the OK button. 

 
44.   The first time you log in to Coeus to work with your inbox, you may wish to view the e-

mail notification settings. These settings allow you to choose whether or not you would 
like any workflow notifications to be sent to your e-mail. 
 
All workflow notification are delivered to your Coeus Inbox, regardless of whether you 
elect to have these notifications delivered to your e-mail as well. 

45.   To view these settings 
Click the File menu. 

 
46.   Click the Preferences menu. 

 
47.   There is one setting for which you can change. 

Click the Email Notifications list. 
 

48.   It is your choice. You can choose to receives theise notifications via e-mail or not. 
 
However, if you choose to turn Email Notifications off, you will need to be diligent about 
visiting your Coeus Inbox regularly to view any item needing your attention, such as 
approving a proposal. 
Click the OK button. 
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49.   Next, begin by navigating to your Coeus Inbox. 
Click the File menu. 

 
50.   Click the Inbox menu. 

 
51.   Your Coeus Inbox will display all items needing your attention.  

 
The Coeus Inbox has two tabbed panels: 
   • Unresolved 
   • Resolved 
 
The Unresolved tab displays the items needing action, such as Proposals awaiting your 
approval. 
The Resolved tab displays those items on which you have already taken action. 
 
If you are an Approver, your Inbox will have proposals waiting for your approval. 
If you are also a Proposal Aggregator, you will see any proposals you have submitted 
that have been denied. 

52.   You can sort the items in your Inbox, under either the Resolved or Unresolved tab, by 
clicking the column header above the column you wish to sort by. 
 
For this exercise, you will sort your Unresolved Items by Deadline. 
Click the Deadline column header. 

 
53.   The Inbox items are now sorted by Deadline Date. 

 
Notice the color coding for each item in your Inbox. 
 
   • RED items are due to the Sponsor in 3 days or less 
   • YELLOW items are due to the Sponsor in 4-5 days 
   • GREEN items are due to the Sponsor in 6-10 days 
   • NO COLOR items (white background) are due to the Sponsor in 10+ days 

54.   You can select any item in your Inbox by clicking on it. 
 
When you select an item in your Inbox, you can view the workflow comments attached to 
the proposal in the Message box below. 

55.   Click the Resolved tab. 
 

56.   The Resolved Tab displays those items on which you have already taken action. 
 
Items move to the Resolved tab automatically once you have taken action on an item in 
your Unresolved list, such as approving or rejecting a proposal. 

57.   The list of items under your Resolved tab will continue to increase as you take action on 
items. You can remove items in your Resolved items by deleting them. 
 
Click the entry containing Proposal 00000285. 
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58.   Click the Delete the selected message button. 

 
59.   Coeus will ask you to confirm that you would like to delete the selected message. 

Click the Yes button. 
 

60.   Proposal 0000061 has been removed from your Resolved Action Items. 
 
Note: Only items that have moved to your Resolved Action Items area can be deleted. 
Click the Unresolved tab. 

 
61.   If you receive new Action Items needing your attention while you are working with your 

Inbox, you will need to refresh your Inbox to view these newly delivered items. 
62.   Click the Refresh the view button. 

 
63.   Your newly delivered Items now appear in your Inbox Unresolved Items list. 
64.   In this topic you have learned to maintain your Inbox by managing Resolved and 

Unresolved action Items. 
End of Procedure. 
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Viewing Submitted Proposals 
 

1.   Selecting the Unresolved tab in your Inbox will display a list of proposals from which you 
can choose the one whose contents you wish to view. 

2.   Click the highlighted proposal, Proposal 00000069. 
3.   Click the Display Selected Proposal button. 

 
4.   The Proposal Details are displayed on a series of panels accessed via tabs. These tabbed 

panels will show basic information about proposals such as the Principal Investigators and 
locations where the proposals' research will be performed. 
 
The Proposal Tab displays such basic details as the proposal's start and end dates as well 
as the Sponsor and funding opportunity Program Number.  

5.   Click the Organization tab. 
 

6.   The Organization tab displays the location(s) where the research is to be performed. 
 
Click the Investigator tab. 

 
7.   The Investigator Tab displays the name(s) of the Principal Investigator and any Co-

Investigator(s) performing research for the proposal. 
 
Click the Key Person tab. 

 
8.   The Key Person tab displays any other named personnel that contribute and play a 

significant role with respect to the proposal. 
 
Click the Special Review tab. 

 
9.   The Special Review panel identifies whether the proposal requires special review or 

approval for work performed, such as working with recombinant DNA or human subjects. 
 
Click the Science Code tab. 

 
10.   UMB is not currently entering information into this tab. 

 
Click the Proposal Narrative button. 
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11.   The Proposal Narrative screen displays the narratives for the proposal. The Narrative 
Types listed are derived from Grants.gov requirements and will vary from proposal to 
proposal depending on the requirements set forth by the sponsor for that particular funding 
opportunity. 
 
Documents can be attached in one of two formats: Microsoft Word or Adobe Acrobat 
(PDF). 
 
Note: You must have Adobe Acrobat Reader installed on your workstation in order to 
view Acrobat (PDF) Files and you must have Microsoft Word installed on your 
workstation to view Microsoft Word files. 

12.   Each narrative has a corresponding icon denoting the file format for that attached item. 
 
Click the PDF Document button beside the Equipment Narrative. 

 
13.   The Document selected is displayed in a new window. 

 
Click the Close button. 

 
14.   You can continue to view any or all of the attached narratives. When you are finished 

viewing the narratives, close the Narrative Window to return to the Proposal Details. 
 
Click the Close button. 

 
15.   In addition to the Proposal Narratives, Proposal Abstracts are available for view. 

 
Click the Proposal Abstracts button. 

 
16.   The Proposal Abstracts Window contains tabs that display technical and non-technical 

abstracts, project summary details and laboratory information in addition to other details. 
 
Each tab containing information is denoted by the Abstract Icon displayed on the 
individual tab. 
 
The types of abstracts required for a given proposal are determined by the sponsor. 

17.   To navigate between the different abstracts, click the appropriate tabs to view the related 
data. 
 
Click the Animal Tab object. 

 
18.   The Animal use data is displayed. 

 
Click the Other Resources tab. 
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19.   The Other Resources for the proposal are displayed. When you are finished viewing the 
abstracts, return to the Proposal Details. 
 
Click the Close button. 

 
20.   The proposal's budget(s) is(are) accessible from the toolbar. 

 
Click the Proposal Budget button. 

 
21.   The Budget Summary window shows summary information about the budget(s) for the 

proposal including total direct and indirect costs and overhead rate type. 
22.   Be sure the budget you wish to view is selected. The selected budget is indicated by the 

pointing hand. 
 
Click the Display button. 

 
23.   The Budget Details are displayed on a series of tabs. One tab represents the Summary of 

the budget. Each Period within the budget is represented by its own tab. The total 
calculations for the budget are represented on the Total tab. 
 
The Summary tab displays the summary information about the budget including Total 
Costs, total Indirect Costs, total Cost Sharing as well as summary calculations for each 
period covered by the proposal. 

24.   Specific Cost Elements listed in each Period within the budget can be accessed by 
clicking the corresponding period tab. 
 
Click the Period 1 tab. 

 
25.   The calculations for each period are based on the Cost Elements entered. 

 
Personnel line items have people who will be paid out of the award funds attached to these 
line items. We can view these Proposal Personnel by visiting the Personnel Budget 
screen. 
 
Click the Senior Personnel Salary Cost Element. 

26.   Click the Personnel Budget for Line Item button. 

 
27.   The Personnel Budget Details window displays all of the personnel who are to be paid 

with this particular cost element's rate. 
 
In this example, the Senior Personnel Salary cost element has the Principle Investigator 
and the Co-Investigator listed. 
 
The details regarding each person and his or her salary is also available to view. 
Click the Details button. 
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28.   The Personnel Budget - Line Item Detail shows the details that make up the calculations 
for the line item with respect to the individual person attached to this line item. 
Additionally, any calculated Modified Total Direct Costs as well as the calculated 
Fringe Benefits are displayed in this window. 
 
Any Cost Sharing for the person on this line item will also be displayed 

29.   Click the Close button. 

 
30.   You may view the details for each individual attached to the line item in the same manner. 

 
Click the Close button. 

 
31.   In addition to Personnel Line Items, you will find Non-Personnel budget items. Each line 

may have additional information such as a Description and detailed budget calculation 
detail for the line item. 
 
Double-click the Equipment Line Item. 

32.   The Budget Line Item Detail is similar to the line detail we viewed for the Personnel 
Line Items.  
 
Note the Apply Inflation button. In this example, Inflation is not applied to the equipment 
line item in this proposal. 

33.   Click the Close button. 

 
34.   Some line items may require Budget Justification. 

Click the Justification button. 
 

35.   The Budget Justification information displays. 
Click the OK button. 

 
36.   Each budget period's line items and calculations are viewable by clicking the 

corresponding tab. 
 
Let's view the next budget period. 
Click the Period 2 tab. 

 
37.   The Period 2 budget is displayed. 

 
Notice that each line item has inflation applied and calculated where applicable. 
Click the Total tab. 

 
38.   The Total tab displays the total calculations by budget period and cost element as well as 

the grand total for the proposal. 
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39.   Click the Summary tab. 
 

40.   In this example, a Modular Budget is being submitted to the sponsor. The details of the 
modular budget are available to view. 

41.   Click the Edit menu. 
 

42.   Click the Modular Budget menu item. 

43.   The Modular Budget window displays budget data similarly to the Detailed Budget 
window. Each period within the budget is represented by a corresponding tab with a 
Cumulative tab displaying the Modular Budget totals for the proposal. 

44.   Each period within the modular budget is viewable. 
Click the Period 2 tab. 

 
45.   Additionally, the total modular budget for all of the budget periods within the proposal is 

viewable. 
Click the Cumulative tab. 

 
46.   The Cumulative tab shows the total Direct and Indirect Costs for the entire budget period. 

Click the Close button. 

 
47.   Closing the Budget window allows you to return to the Proposal Details. 

Click the Close button. 
 

48.   You have successfully viewed the details of a proposal submitted for approval. 
End of Procedure. 
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Approving a Proposal 
 

1.   We begin the proposal approval process from within the Proposal Details screen. 
 
Click the Approve Proposal button. 

 
2.   The Proposal Routing screen displays the various stops along the proposal's approval 

path. Each department/division's approval stops can be viewed. 
 
Currently, we are viewing the approval stop as well as the proposal status at the 
Physiology Department. 

3.   We can display the next stop on the approval route after the proposal is approved at the 
Physiology level. 
 
Click the SOM tree item. 

 
4.   The next two stops at the School Level are displayed. Once we approve the proposal it 

will go to Sequential Stop 1 then on to Sequential Stop 2. 
 
Click the Approve button. 

 
5.   Decision: Please make a selection from the options listed below. 

• Approve the proposal yourself 
Go to step 6 on page 1 

• Pass your approval to another Approver 
Go to step 14 on page 2 

6.   You may add a comment that will be viewed at the next stop on the proposal's approval 
path as well as by the original aggregator. 
 
Enter a valid value e.g. "Approved" in the comments box. 

7.   Click the Approve button. 

 
8.   Notice the status for the proposal now reflects Approved. 

 
Click the Close button. 

 
9.   We have now completed our task with this proposal. 

 
Click the Close button. 
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10.   Notice the approved proposal is currently listed under the Unresolved Action Items tab. 
We must refresh the Inbox view to move the proposal to the Resolved Action Items tab. 
 
Click the Refresh the view button. 

 
11.   Proposal 0000069 has now been removed from the Unresolved Action Items panel. 

 
Click the Resolved tab. 

 
12.   Proposal 0000069 has been moved to the Resolved Action Items panel. 
13.   You have successfully approved a proposal and forwarded the proposal to the next stop on 

the approval path. 
End of Procedure. Remaining steps apply to other paths. 

14.   In order to pass your approval on to another approver, you must first add an alternate 
approver (or approvers if you would like to pass your approval to a selection of 
approvers.) 
 
Once your alternate(s) is(are) selected, you then may elect to pass your approval to the 
alternate(s). 

15.   Click the Add Approver button. 
 

16.   The User Search screen appears. For our example, we will search for our alternate 
approver Sharon Bowser, by last name. 
Click the User Name cell. 

 
17.   We will utilize a wildcard, denoted by the * character. This will return any records in the 

database where bowser + any other characters exist. 
 
Enter a valid value e.g. "bowser* in the User Name cell. 

18.   Click the Find button. 

 
19.   Sharon Bowser's record is displayed and selected. 

Click the OK button. 

 
20.   It is a good practice to send a comment to your alternate explaining why you have chosen 

this user to approve a proposal either in addition to or in lieu of yourself. 
 
Enter a valid value e.g. "Please approve this proposal" in the comments box. 

21.   Select the Approver to whom you wish to pass your approval. 
 
Click in the Bowser, Sharon selection. 

22.   Click the Pass button. 
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23.   The Proposal Routing window displays the approval status as well as indicating the 
approval of the proposal has been passed to another approver within this Sequential Stop. 
Click the Close button. 

 
Go to step 9 on page 1 

 



 
Job Aid

 

Date Created: 7/21/2008  
 

Page 1

 

Rejecting a Proposal 
 

1.   Begin the proposal rejection process from within the Proposal Details screen. 
 
Click the Approve Proposal button. 

 
2.   The Proposal routing screen displays the current stop on the proposal's routing map and 

the its status at this point. 
 
Click the Reject button. 

 
3.   If you elect to reject a proposal you are required to enter a comment detailing why the 

proposal is being rejected. 
 
 Enter a valid value e.g. "Please limit your Period 2 budget to $150,000" in the 
Comments box. 

4.   Click the Reject button. 

5.   Notice that the status for the proposal is now Rejected. 
 
Click the Close button. 

 
6.   We have now completed our task with this proposal. 

 
Click the Close button. 

 
7.   Notice that the rejected proposal is currently listed on the Unresolved Action Items panel. 

We must refresh the Inbox view to move the proposal to the Resolved Action Items panel. 
8.   Click the Refresh the view button. 

 
9.   Proposal 0000069 has now been removed from the Unresolved Action Items panel. 
10.   You have now practiced rejecting a proposal that was submitted for your approval. 

End of Procedure. 
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